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PREFACE

We are proud to announce the fourth edition of the Exploring Windows series in
conjunction with Microsoft® Office 2000. The series has expanded in two impor-
tant ways—recognition by the Microsoft Office User Specialist (MOUS) program,
and a significantly expanded Web site at www.prenhall.com/grauer. The Web site
provides password-protected solutions for instructors and online study guides
(Companion Web sites) for students. Practice files and PowerPoint lectures are
available for both student and instructor. The site also contains information about
Microsoft Certification, CD-based tutorials for use with the series, and SkillCheck®
assessment software.

The organization of the series is essentially unchanged. There are separate
titles for each application—Word 2000, Excel 2000, Access 2000, and PowerPoint
2000, a book on Windows® 98, and eventually, Windows® 2000. There are also four
combined texts— Exploring Microsoft Office Professional, Volumes I and II,
Exploring Microsoft Office Proficient Certification Edition, and Brief Office.
Volume I is a unique combination of applications and concepts for the introduc-
tory computer course. It covers all four Office applications and includes support-
ing material on Windows 95/98, Internet Explorer, and Essential Computing Con-
cepts. The modules for Word and Excel satisfy the requirements for proficient
certification. The Proficient Certification Edition extends the coverage of Access
and PowerPoint from Volume I to meet the certification requirements, but
(because of length) deletes the units on Internet Explorer and Essential Comput-
ing Concepts that are found in Volume 1. Volume II includes the advanced fea-
tures in all four applications and extends certification to the expert level. Brief
Office is intended to get the reader “up and running,” without concern for certi-
fication requirements.

The Internet and World Wide Web are integrated throughout the series.
Students learn Office applications as before, and in addition are sent to the Web
as appropriate for supplementary exercises. The sections on Object Linking and
Embedding, for example, not only draw on resources within Microsoft Office, but
on the Web as well. Students are directed to search the Web for information, and
then download resources for inclusion in Office documents. The icon at the left of
this paragraph appears throughout the text whenever there is a Web reference.

The Exploring Windows series is part of the Prentice Hall custom-binding
(Right PHit) program, enabling instructors to create their own texts by selecting
modules from Volume I, Volume II, the Proficient Certification Edition, and/or
Brief Office to suit the needs of a specific course. An instructor could, for exam-
ple, create a custom text consisting of the proficient modules in Word and Excel,
coupled with the brief modules for Access and PowerPoint. Instructors can also
take advantage of our ValuePack program to shrink-wrap multiple books together
at a substantial saving for the student. A ValuePack is ideal in courses that require
complete coverage of multiple applications.

Instructors will want to obtain the Instructor’s Resource CD from their Pren-
tice Hall representative. The CD contains the student data disks, solutions to all
exercises in machine-readable format, PowerPoint lectures, and the Instructor
Manuals themselves in Word format. The CD also has a Windows-based test gen-
erator. Please visit us on the Web at www.prenhall.com/grauer for additional
information.
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FEATURES AND BENEFITS

Exploring Microsoft ®
PowerPoint 2000 is written
for the computer novice and
assumes no previous knowledge
of the operating system. A 64-
page appendix introduces the
reader to the essentials of Win-
dows 95/98/NT and emphasizes
the file operations he or she will

need.

Chapter 1 describes how fo
create an effective presentation
quickly and easily. The student is
led through the basic steps, from
developing the content, to apply-
ing a template, to creating a
slide show. All material is pre-
sented in conceptual form, fol-
lowed by hands-on exercises at
the computer.

PowerPoint is easy to learn because it is a Windows application and follows
the conventions associated with the common user interface. Thus, if you already
know one Windows application, it is that much easier to learn PowerPoint because
you can apply what you know. It's even easier if you use Word, Excel, or Access
since there are over 100 commands that are common to Microsoft Office.

The chapter begins by showing you an existing PowerPoint presentation so
that you can better appreciate what PowerPoint is all about. We discuss the vari-
ous views within PowerPoint and the advantages of each. We describe how to
modify an existing presentation and how to view a presentation on the computer.
You are then ready to create your own presentation, a process that requires you
10 focus on the content and the message you want to deliver. We show you how
to enter the text of the presentation, how 1o add and/or change the format of a
slide, and how to apply a design template. We also explain how to animate the
presentation to create additional interest.

As always, learning is best accomplished by doing. so we include three hands-
on exercises that enable you to apply these concepts at the computer. One final
point before we begin, is that while PowerPoint can help you create attractive pre-
sentations, the content and delivery are still up to you.

A POWERPOINT PRESENTATION

A PowerPoint presentation consists of a series of slides such as those in Figure 1.1.
The various slides contain different elements (such as text, clip art, and WordArt),
yet the presentation has a consistent look with respect to its overall design and
color scheme. You might think that creating this type of presentation is difficult,
but it isn't. It is remarkably easy, and that is the beauty of PowerPoint. In essence,
PowerPoint allows you to concentrate on the content of a presentation without
worrying about its appearance. You supply the text and supporting elements and
leave the formatting to PowerPoint.

In addition to helping you create the presentation, PowerPoint pruvld::s a
variety of ways 1o deliver it. You can show the presentation on a computer using
animated transition effects as you move from one slide to the next. You can include
sound and/or video in the presentation, provided your system has a sound card and
speakers. You can also automate the presentation and distribute it on a disk for
display at a convention booth or kiosk. If you cannot show the presentation on a
computer, you can convert it to 35-mm slides or overhead transparencies.

PowerPoint also gives you the ability to print the presentation in various
ways 1o distribute to your audience. You can print one slide per page, or you can
print miniature versions of each slide and choose between two, three, four, six, or
even nine slides per page. You can prepare speaker notes for yourself consisting
of a picture of each slide together with notes about the slide. You can also print
the text of the presentation in outline form. Giving the audience a copy of the
presentation (in any format) enables them to follow it more closely, and to take
it home when the session is over.

POLISH YOUR DELIVERY
The speaker is still the most important part of any presentation and a poor
the
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I Introduction to PowerPoint

Robert Grauer and Maryann Barber

The Essence of PowerPoint

You focus on content

« Enter your thoughts in an outline or
directly on the individual slides

PowerPoint takes care of the design

« Professionally designed templates

« Preformatted slide layouts

(3 follows the same conventions as
every Windows application

It uses the same menus and command
structure as other Office applications
Keyboard shortcuts also apply, such as
Ctrl+B for boldface

Help is only a mouse click away

(o) Tle Side (b) Bollet Side
Add Other Objects for Interest exibility in Output
WP Computer presentations
Clipart, WordArt,
o :’mnimim Overhead transparencies
charts Presentation on the Web
Charts from 35mm slides
mﬁ i Audience handouts
thevias” Speaker notes
Animation and
sou
{0 Gip At @ Gp At
PowerPoint is Easy To Leam

{e) Animated Text
FIGURE 1.1 A PowerPoint Presenation
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HANDS-ON EXERCISE 2 STEP 2 Complete the Outline

> You should see the text of the presentation as shown in Figure 2.4b. Click
The Internet as a Resource on the fourth slide that describes the origin of the word dinosaur.
- " ; - > Click the lightbulb to see the tip offered by the Office Assistant. Click the
To import slides from an outline; to download a picture from the option to ignore the style rule for this presentation.
Internet and use it in o PowerPoint presentation. Use Figure 2.4 as a guide in

: ; 9 : > Right click the word “deinos™ that is flagged as a misspelling because it is not
the exercise. The exerciss: requires that you have an Infernet connection. in the English dictionary. Click Ignore All 1o accept the term without flag-
ging it as a misspelling. Accept the spelling of “sauros” in similar fashion.
> Select (double click) deinos, then click the Bold and Italics buttons on the

Formatting toolbar. Use the Format Painter (see boxed tip) to copy this for-
matting to “sauros™ and to “Sir Richard Owen".
> Click outside the placeholder. Save the presentation.

STEP 1: Insert the Word Outline

> Start PowerPoint, click the option button to create a Blank Presentation, and
click OK. If PowerPoint is already started, click the New button on the Stan-
dard toolbar to begin a new presentation.

> You should see the New slide dialog box with the Auto Layout for the title
slide already selected. Click OK to create the title slide.

> Enter Extinction of the Dinosaurs as the title of the presentation and your Office Assistant
name as the author. Save the as ion of the in
the Exploring PowerPoint folder. Format Painter ——
» Pull down the Insert menu and click the Slides from Outline command to dis- Bold bufton ———
play the Insert Outline dialog box in Figure 2.4a. Click the drop-down arrow -
on the Look in list box to select the Exploring PowerPoint folder. Select the Nolic butlon — Dinosaur
Extinction of Dinosaurs Word document and click the Insert button.
> The Word document is imported into the presentation and converted (o indi- et AR ; o he
vidual slides. Any paragraph that has been formatted in the Headingl style Gekopione __—| i eard
is converted 1o the title of a PowerPoint slide. ignore style rule - 1842
> Save the presentation.
New bution —____
Click on fourth slide
Click o select drive
and folder T i
R
| 9 B 008 %1 =0 z 0
(b) Complete the Outline (step 2)
Click filename FIGURE 2.4 Hands-on Exercise 2 (continued)
THE FORMAT PAINTER
‘The Format Painter copies the formatting of the selected text to other
places in a presentation. Select the text with the formatting you want to
copy. then click or double click the Format painter button on the Stan-
- dard toolbar. Clicking the button will paint only one selection. Double
—— e clicking the button will paint multiple selections until the feature is turned
— & S = off by again clicking the Format Painter button. Either way, the mouse
{a) Insert the Word Outline (step 1) pointer changes to a paintbrush, which you can drag over text to give it
the identical formatting characteristics as the original selection.
FIGURE 2.4 Honds-on Exercise 2
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The hands-on exercises guide the
reader every step of the way and
are illustrated with large, full-

color screen captures that are

clear and easy to read. This
example is taken from Chapter 2
and describes how to download
resources from the Web for inclu-
sion in a PowerPoint presenta-

tion.

Students are encouraged to use =
resources from the Web, but are —
also taught the importance of
respecting a copyright and citing
references appropriately. The

slide at the bottom of the page

was created through the Format
Background command, and it

gives an entirely new look to a (HATTEL B ARG oy
PowerPoint presentation.
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6. Create an Agenda: Open the completed presentation from the previous exer-
cise, the

FIGURE 3.17  (reate an Agenda (Exercise 6)

serve as the basis of future presentations

MICROSOFT POWERPOINT 2000

then modify the Agenda slide to include hyperlinks to the remaining
slides in the presentation as shown in Figure 3.17.
(a) Change the existing entries on the agenda slide to match the other slides
in the presentation. Delete the reference to any slide that is no longer
in the presentation. You also have to change the title of the existing
entries so that they are consistent with the title of the associated slides.
(b) Convert each bulleted item in the agenda to a hyperlink that points to
the appropriate slide in the presentation
(¢) Modify the slide master to include a uniform set of navigation buttons
that points to the first, previous, next, and last slides in the presentation.
Place the buttons as shown in Figure 3.1

(d) Include today’s date and the slide number on each slide of the presen-
tation (except for the title slide).

(¢) Print the completed presentation for your instructor in the form of audi-
ence handouts, two slides per page. Print the outline in addition to the
audience handouts.

(f) Print the title slide on a page by itself and use that as a cover page for
the assignment.

7. Create Your Own Template: Open the Financial Overview presentation
from the previous exercise and apply a different design template as shown
in Figure 3.18. The original Financial Overview presentation from exercises
5 and 6 has now been modified with respect to both content and design. This
exercise has you convert the modified presentation to a template that will

Ne

(a) Pull down the File menu, click the Save As command, and specify Design
Template as the file type. Choose a name that will indicate that this is
your template as opposed to one supplied by PowerPoint. The template
will be saved automatically in the Templates folder, where it will be
accessible in future sessions. (Save the template to a floppy disk if you
do not have your own computer.)

b) You can open the new template by pulling down the File menu, clicking

and selecting the template from the open list box on the

General
tab. (You have to double click the template from Windows Explorer if
you do not have your own computer.)

You can also add the newly ereated template to those suggested by
the AutoContent

mand, click the General command, then double click the AutoContent
Wizard. Click the Next button and select the category where you want
your template to be displayed. Click the Add button, find your template,
and click OK. The next time you start the AutoContent Wizard, you will
be able to create a presentation based on your financial template
8. Test Your Template: Close any presentations that are currently open. Pull
down the File menu, click the New command, and click the General tab
where you should see the template that was created in problem 7. Select the
template such as Bob's Financial Template in Figure 3.19 and click OK. Pow
erPoint will start a new presentation based on your template and as
presentation a default name of “Presentation” followed by a number.

zard. Pull down the File menu, click the New com-

ssign tha

FIGURE 3.18

appropriate category (i.e

Every chapter provides multiple
assignments to avoid repetition
from one semester to the next.
The exercises vary in scope and
encourage the student fo create a
variety of presentations. Instruc-
tors can download all solutions

from our password-protected
Web site.

Every chapter also contains a
number of less-structured case
studies to challenge the student.
The Web icon appears through-
out the text whenever the reader
is directed to the Web as a
source of additional information.
The solution to every exercise is

also provided on a CD for
instructors.
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(reate Your Own Template (Exercise 7)

Another way to access your template is to double
tent Wizard from the General tab, then select your pre

the category you selected in exercise 7). Summa-
rize the steps to create and access a template in a short note to your instruc-
tor.

ick the AutoCon-
sentation from the

ING A PRESENTATION ﬁ ‘
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You don’t have to be an artist to
use the drawing tools within Pow-
erPoint. Chapter 3 shows how to
modify existing clip art to create
new drawings to enliven any
presentation. If's easy to do, once
the reader redlizes that clip art is
made up of individual objects that
can be manipulated through
various tools on the Drawing
toolbar.

The Web is an integral part of
Office 2000. Students learn how
to save PowerPoint presentations
as Web pages (HTML documents),
and how to upload those pages
to a Web server. The Exploring
Windows series is distinguished
by its unique conceptual presenta-
tions that are followed by hands-
on exercises at the computer.

The mavigation controls at the bottom of the window provide additional
options for viewing within Internet Explorer. (The controls were created auto-

PRESENTATIONS ON THE WEB

Perhaps you have already created a home page and have uploaded it to the World
Wide Web, If so, you know that the process is not difficult, and have experienced
the satisfaction of adding your documents to the Web. If not, this is a good time
to learn. This section describes how to insert hyperlinks into a PowerPoint pre-
sentation, and then shows you how to convert a PowerPoint presentation into a
series of Web pages for display on the Web or local area network.

All Web pages are written in a language called HTML (HyperText Markup
Language). Initially, the only way to create a Web page was to learn HTML.
Office 2000 simplifies the process because you can create the document in any
Office application, then simply save it as a Web page. In other words, you start
PowerPoint in the usual fashion and enter the text of the presentation with basic
formatting. However, instead of saving the document in the default format (as a
PowerPoint presentation), you use the Save As Web Page command to convert
the presentation to HTML.

PowerPoint does the rest and generates the HTML statements for you. You
can continue to enter text and/or change the formatting for existing text just as
you can with an ordinary presentation. Hyperlinks can be inserted at any time,
either through the Insert Hyperlink command or through the corresponding but-
ton on the Standard toolbar,

Figure 2.5 displays the title slide of a presentation entitled “Widgets of
America™ as viewed in Internet Explorer, rather than in PowerPoint. The Inter-
net Explorer window is divided into two vertical frames and is similar to the Nor-
mal view in PowerPoint. The left frame displays the title of each slide, and these
titles function as links; that is, you can click any title in the left frame and the cor-
responding slide will be displayed in the right panc. You can also click and drag
the border separating the panes to change the size of the panes. Note, 100, the
address in the Address bar of Internet Explorer that indicates the presentation is
stored on a local drive as opposed to a Web server.

matically in conjunction with the Save As Web Page command when the presen-
tation was saved initially.) The Show/Hide Outline button at the bottom left of
the window toggles the left (outline) pane on and off. The Expand/Collapse Out-
line button appears to the right of the outline when the outline is visible and lets
you vary the detail of the outline. The Show/Hide Notes button toggles a notes
pane on and off at the bottom of the slide. The left and right arrows move to the
previous and next slide, respectively. And finally, the Full Screen Slide Show but-
ton at the lower right creates a slide show on the Internet that is identical to the
slide show viewed within PowerPoint.

Uploading a Presentation

Creating a Web document is only the beginning in that you need to place the pages
on the Web so that other people will be able to access it. This in turn requires
you to obtain an account on a Web server, a computer with Internet access and
adequate disk space to hold the various pages you create. To do so, you need to
check with your system administrator at school or work, or with your local Inter-
net provider, to determine how to submit your page when it is complete.

Realize, however, that even if you do not place your presentation on the
Web, you can still view it locally on your PC. This is the approach we follow in
the next hands-on exercise, which enables you to create an HTML document and
see the results of your effort. Your document is stored on a local drive (c.g., on
drive A or drive C) rather than on a Web server, but it can still be viewed through
Internet Explorer (or any other browser). After you have completed the exercise,
you (and/or your instructor) can determine if it is worthwhile to place your page
on your school’s or university's server, where it can be accessed by anyone.

Show/Hide Notes bution

Collopse/Expand Outline button
Show/Hide Outline button

Full Screen Slide Show button

FIGURE 2.5 Presentations on the Web
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INTRODUCTION TO
POWERPOINT.
PRESENTATIONS
MADE EASY

OBJECTIVES

After reading this chapter you will be able to:

1. Describe the common user interface; give several examples of how
PowerPoint follows the same conventions as other Office applications.

2. Start PowerPoint; open, modify, and view an existing presentation.

Describe the different ways to print a presentation.

4. List the different views in PowerPoint; describe the unique features of
each view.

5. Use the Outline view to create and edit a presentation; display and
hide text within the Outline view.

6. Add a new slide to a presentation; explain how to change the layout
of the objects on an existing slide.

7. Use the Microsoft Clip Gallery to add and/or change the clip art on
a slide.

8. Apply a design template to a new presentation; change the template .
in an existing presentation. o

9. Add transition effects to the slides in a presentation; apply build
effects to the bullets and graphical objects in a specific slide.

OVERVIEW ’

This chapter introduces you to PowerPoint, one of the four major appli-
cations in the Professional version of Microsoft Office (Microsoft Word,
Microsoft Excel, and Microsoft Access are the other three). PowerPoint
enables you to create a professional presentation without relying on oth- |
ers, then it lets you deliver that presentation in a variety of ways. You can
show the presentation on the computer, on the World Wide Web, or via
35-mm slides or overhead transparencies.
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PowerPoint is easy to learn because it is a Windows application and follows
the conventions associated with the common user interface. Thus, if you already
know one Windows application, it is that much easier to learn PowerPoint because
you can apply what you know. It’s even easier if you use Word, Excel, or Access
since there are over 100 commands that are common to Microsoft Office.

The chapter begins by showing you an existing PowerPoint presentation so
that you can better appreciate what PowerPoint is all about. We discuss the vari-
ous views within PowerPoint and the advantages of each. We describe how to
modify an existing presentation and how to view a presentation on the computer.
You are then ready to create your own presentation, a process that requires you
to focus on the content and the message you want to deliver. We show you how
to enter the text of the presentation, how to add and/or change the format of a
slide, and how to apply a design template. We also explain how to animate the
presentation to create additional interest.

As always, learning is best accomplished by doing, so we include three hands-
on exercises that enable you to apply these concepts at the computer. One final
point before we begin, is that while PowerPoint can help you create attractive pre-
sentations, the content and delivery are still up to you.

A POWERPOINT PRESENTATION

A PowerPoint presentation consists of a series of slides such as those in Figure 1.1.
The various slides contain different elements (such as text, clip art, and WordArt),
yet the presentation has a consistent look with respect to its overall design and
color scheme. You might think that creating this type of presentation is difficult,
but it isn’t. It is remarkably easy, and that is the beauty of PowerPoint. In essence,
PowerPoint allows you to concentrate on the content of a presentation without
worrying about its appearance. You supply the text and supporting elements and
leave the formatting to PowerPoint.

In addition to helping you create the presentation, PowerPoint provides a
variety of ways to deliver it. You can show the presentation on a computer using
animated transition effects as you move from one slide to the next. You can include
sound and/or video in the presentation, provided your system has a sound card and
speakers. You can also automate the presentation and distribute it on a disk for
display at a convention booth or kiosk. If you cannot show the presentation on a
computer, you can convert it to 35-mm slides or overhead transparencies.

PowerPoint also gives you the ability to print the presentation in various
ways to distribute to your audience. You can print one slide per page, or you can
print miniature versions of each slide and choose between two, three, four, six, or
even nine slides per page. You can prepare speaker notes for yourself consisting
of a picture of each slide together with notes about the slide. You can also print
the text of the presentation in outline form. Giving the audience a copy of the
presentation (in any format) enables them to follow it more closely, and to take
it home when the session is over.

POLISH YOUR DELIVERY

The speaker is still the most important part of any presentation and a poor
delivery will kill even the best presentation. Look at the audience as you
speak to open communication and gain credibility. Don’t read from a pre-
pared script. Speak slowly and clearly and try to vary your delivery. Pause
to emphasize key points and be sure the person in the last row can hear you.
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| The Essence of PowerPoint

You focus on content

« Enter your thoughts in an outline or
directly on the individual slides

PowerPoint takes care of the design
= Professionally designed templates
« Preformatted slide layouts

(a) Title Slide

(b) Bullet Slide

‘ Add Other Objects for Interest

Clipart, WordArt,
and organization
charts

Charts from
Microsoft Excel
Photographs from
the Web

Animation and
sound

| | Flexibility in Output
Computer Bféseniztions |

DN

Overhead transparencies /7 “\
Presentation on the Web \&

35mm slides

Audience handouts
Speaker notes

(c) Clip Art

(d) Clip Art

’ PowerPoint is Easy To Leam

It follows the same conventions as
every Windows application

It uses the same menus and command
structure as other Office applications

Keyboard shortcuts also apply, such as
Ctrl+B for boldface

Help is only a mouse click away

e

(e) Animated Text

FIGURE 1.1 A PowerPoint Presentation

(f) Word Art
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Menu bar
Standard toolbar

Formatting toolbar

Minimize button

Restore button

Close button

Scroll bar

View buttons

The desktop in Figure 1.2 should look somewhat familiar, even if you have never
used PowerPoint, because PowerPoint shares the common user interface that is
present in every Windows application. You should recognize, therefore, the two
open windows in Figure 1.2—the application window for PowerPoint and the doc-
ument window for the current presentation.

Each window has its own Minimize, Maximize (or Restore), and Close but-
tons. Both windows have been maximized and thus the title bars have been
merged into a single title bar that appears at the top of the application window.
The title bar indicates the application (Microsoft PowerPoint) as well as the name
of the presentation on which you are working (Introduction to PowerPoint). The
menu bar appears immediately below the title bar and it provides access to the
pull-down menus within the application.

The Standard and Formatting toolbars are displayed below the menu bar and
are similar to those in Word and Excel. Hence, you may recognize several but-
tons from those applications. The Standard toolbar contains buttons for the most
basic commands in PowerPoint such as opening, saving, and printing a presenta-
tion. The Formatting toolbar, under the Standard toolbar, provides access to for-
matting operations such as boldface, italics, and underlining.

The vertical scroll bar is seen at the right of the document window and indi-
cates that the presentation contains additional slides that are not visible. This is
consistent with the status bar at the bottom of the window that indicates you are
working on slide 1 of 6. The Drawing toolbar appears above the status bar and
contains additional tools for working on the slide. The view buttons above the
Drawing toolbar are used to switch between the different views of a presentation.
PowerPoint views are discussed in the next section. The Windows 95/98 taskbar
appears at the bottom of the screen and shows you the open applications.

owerPoint

Robert Grauer and Maryann Barber

Drawing toolbar

Status bar
Task bar

FIGURE 1.2  Introduction to PowerPoint
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